
روتوش و ویرایش 



، تراز سفیدی ACR، محیط  Bridge ADOBE، نرم افزار RAWفایل : مباحث

 ADOBEسپس در . عکاسی کرده و در یک فولدر ذخیره کنید RAWبادوربین دیجیتال خود با فایل : ۱تمرین 

BRIDGEد فایل ها را سازماندهی کنید و بر اساس موارد گفته شده تراز سفیدی عکس خود را اصلاح نمایی.



(RAW)فایل خام 

. است یکی از مهمترین مفاهیم عکاسی دیجیتال حرفه ای  RAWخروجی 

.توسط یک دوربین عکاسی دیجیتال ثبت می شود RAWتصویری که با فورمت خام 

.  شامل فایل دیجیتالی است که کلیه اطلاعات تصویر را در بر دارد و بدون فرایند پردازش در دوربین بدست آمده است

.ته استیک فایل خام از کلیه اطلاعات عکس می باشد که دوربین ثبت نموده و هنوز پردازشی بر روی آن انجام نگرف RAWدر واقع 

تبدیل نمود تا قابلیت نمایش و  TIFFیا  JPEGبرای استفاده از این فایل، بایستی ابتدا آن را به یکی از فورمتهای رایج عکس مثل 

.چاپ را پیدا کند

همه اطلاعات اولیه تصویر موجود می باشد، مناسب ترین فرمت برای پردازش و ویرایش تصاویر  RAWبه علت اینکه در فایل 

.ممکن را بدست آورد( و گستردگی)دیجیتال است و با کمک آن می توان از عکس ثبت شده، بیشترین کیفیت 

.ذخیره شوند  NEFو  CR2شما می تواند در دو فرمت RAWفایل های خام



توانند با فرمت بسیاری از دوربین های دیجیتالی می. یک فایل خام دوربین شامل داده های تصویر پردازش نشده از حسگر تصویری یک دوربین دیجیتالی است

.فایل خام دوربین تصویر را ذخیره کنند

. جاد کنداطلاعات تصویر را برگردان کند و تنظیمات و تغییرات ای-به جای دوربین–مزیت فایل های خام دوربین این است که آن ها به عکاس اجازه می دهند 

از آن جهت که زمانی که یک عکس خام دوربین می گیرید (. با دوربین شما را به پردازش های دوربین شما محدود می کندJPEGدر مقابل، گرفتن تصویر )

.دوربین هیچ پردازش تصویری انجام نمی دهد 

تقل ، می افتد این است ، که زمانی که دکمه شاتر فشرده می شود و تصویر ثبت می گردد ؛ اطلاعات بصورت مس RAWاتفاقی که در هنگام ثبت تصویر با فرمت 

در یک فایل خام  Luminance، روشنایی Saturation، غلظت Hueاین اطلاعات برای رنگ . هر رنگ بصورت جداگانه به پردازشگر دوربین می رسد 

.ذخیره می گردد 

.  این اطلاعات با هم ترکیب شده و گستردگی خود را از دست می دهند JPEGدر فایل های 

کامل داششته را بصورتات زمانی که می خواهیم فایلی را ویرایش کنیم ، عموماً رنگ ها و نورهای آن را ویرایش می کنیم بنابراین احتیاج به فایلی داریم که اطلاع

.و محدود نباشد 



ایلهای در داخل ف. گردیمشخصا برای استفاده از این فرمت، باید یا از نرم افزار های مبدل کارخانه سازنده دوربین استفاده کرد و یا از نرم افزارهای شرکت های

RAW  یکpreview  تبدیل شده نیز وجود دارد که دوربین بر اساس اینPreview ، هیستوگرام عکس و پیش نمایش آن را درLCD نمایش می دهد  .

این . ی گیردورت ماین تبدیل درونی نیز توسط پردازشگر دوربین و با استفاده از کنترل هایی نظیر شارپنس، کنتراست، اشباع، منحنی تونال، وایت بالانس ص

اما این . تهیه کنید، می توانید با آنها بر خروجی عکس خود کنترل داشته باشید JPEGکنترلهای دقیقا همان هایی هستند که وقتی بخواهید یک خروجی 

هیستوگرام اولیه و نیز نمایش اولیه عکس در ،LCDدرونی فایل و بالطبع در نمایش  Previewتاثیری ندارند و تنها بر همان  RAWکنترلها بر فایل 

.موثر خواهند بود RAWمبدلهای 

.تاثیر دارند، سرعت شاتر، دیافراگم و ایزو است RAWتنها متغیرهایی که بر اطلاعات فایل 

.  ذخیره نمایدوربینم دبرای ایجاد فایل خام دوربین، دوربین دیجیتال خود را تنظیم کنید تا فایل ها را در درون خود، در صورت امکان با فرمت اختصاصی فایل خا

crwیا  (Nikonاز nefزمانی که فایل را از دوربین خود دانلود می کنید، دارای پسوندی مانند   یا فتوشاپ، می توانید  Bridgeدر بریج. است Canonاز )

می. و بقیه سازندگان را پردازش کنید و حتی می توانید چندین تصویر را به طور همزمان پردازش کنید Canon،Kodak Leicaفایل های خام دوربین از 

.تبدیل کنید PSDیا  DNG،JPEG،TIFFتوانید سپس فایل های خام اختصاصی دوربین را به فرمت 





ردن، بریج یک برنامه مدیریت فایل های دیجیتالی است و به ما راه های قدرتمندی برای پیدا ک. استccفتوشاپ یک برنامه ی همراه برایادوبی بریج

.مدیریت و سازماندهی مجموعه های تصویری که روز به روز در حال پیشرفت هستند؛ می دهد

Bridge یک مرورگر فایل است که به ما امکان می دهد تصاویرمان را پیدا کنیم ، سازماندهی ، انتخاب و باز کنیم.

ل است ولی در واقع یک برنامه مستقل است و جهت باز شدن نیازی به فتوشاپ ندارد بلکه مثccفتوشاپ درست است که بریج یک برنامه همراه

.هر برنامه دیگری می توان از طریق منوی استارت ویندوز آن را باز کرد

 Adobe Bridgeادوبی بریج
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ادوبی بریجنحوه بارگیری عکس از دوربین با استفاده از

بازccفتوشاپدرراآنهاوکنیمسازماندهیراخودتصاویرتاکنیماستفادهآنازتوانیممیباشد،کردهبارگیریراماهایعکسبریجادوبیکههنگامی
.کنیم

Photoنامبهجداگانهبرنامهیکازواقعدربریجادوبیتصاویر،بارگیریبرای Downloaderکندمیاستفاده.

BrowseوبرویدFileمنویبهصفحه،بالایدرمنونواردر،ccفتوشاپدرکهاستاینراهترینساده.کنیدبازرابریجادوبیابتدا in Bridgeرا

:کنیدانتخاب
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را  Get Photos from Cameraبروید و  Fileدر ادوبی بریج در بالای صفحه، به منوی ،Photo Downloaderبرای باز کردن 

:انتخاب کنید



راه دیگر کلیک کردن بر روی نماد دوربین در نوار ابزار است که در سمت چپ بالای اینترفیس قرار دارد



Batch Renameتغیر نام گروهی تصاویر 

عکس در مراسم عید نوروز گرفته اید و می خواهید همه عکس ها به نام   ۱00گاهی لازم است همه یا تعدادی از تصاویر را با هم تغییر دهیم مثلاً 

NOROOZ 99 زینه کلیک کنید با یک شماره تغییر نام داده شوند با این گزینه این کار قابل انجام است کافی است تصاویر را انتخاب کنید و روی این گ

.و در پنجره ای که باز می شود روش نام گذاری را تعیین کنید

و در سطر بعد یک خط تیره و در سطر ( فقط سال)و در سطر بعد تاریخ امروز  NOROOZکلمه  Textروبروی کادر  New Filenamesدر بخش 

.نام فایل را می بینید previewآخر شماره ترتیبی به هر عکس را میدهد ونتیجه آنکه در پایین پنجره در بخش 

File Infoاطلاعات فایل 

رایت ی پبا این انتخاب این گزینه پنجره ای باز می شود که کلیه اطلاعات موجود در عکس نمایش داده می شود، اطلاعات کلی مانند مولف اثر و حق ک

…و(مکان تصویر برداری) GPSدر سربرگ اول و در سربرگ های بعدی اطلاعات دوربین و اطلاعات … و



Camera Rawگزینه 

در دوربین ذخیره شده اند را نیز  Rawقرار دارد می تواینم عکس هایی که با فرمت  Refineبا انتخاب این آیکن که در کنار آیکن 
.مشاهده نمود

Sort Manuallyگزینه 

.با استفاده از این گزینه می توان نحوه ی نشان دادن عکس ها را بر اساسی که مد نظر کاربر است تنظیم نمود

باز کردن فایل های اخیر

.برای این کار بر روی آیکن پوشه در سمت چپ بالای تصویر کلیک کنید تا فایلهایی که اخیرا مشاهده کرده اید را ببینید

ساخت یک فولدر

.با انتخاب آیکن دوم از سمت راست بالای صفحه می توان یک فولدر جدید با نام دلخواه ساخت 

حذف یک فایل

.برای حذف یک فایل کافی است پس از انتخاب فایل مد نظر بر روی آیکن اول سمت راست بالای صفحه کلیک کرد



ادوبی بریجدر (Folders)پانل پوشه ها 

پانلوFoldersهاپوشهپانلکهاینجاست.استکامپیوتردرعکسیکیافتندهیممیانجامبریجادوبیکردنبازازبعدکهکاریاولینمعمولا

.شوندمیمطرحFavoritesهامندیعلاقه

کهیدرختساختارازپانلاین.استکردهفراهمراهادایرکتوریوهاپوشهطریقازکامپیوتردرجستجوامکانچپسمتبالا،درهاپوشهپانل

.کندمیاستفادهکاراینبرایاست؛آسانوآشناساختاری

راهامثلثاینرویکردنکلیک.دهدمینشانراآنداخلهایپوشهوشودمیبازپوشهآنپوشه،هرچپسمتمثلثرویبرکردنکلیکبا

.برسیدخواهیدمیکهعکسیبهتادهیدادامه

همانطور که مشاهده می کنید این . قرار دارد Eدرایو را انتخاب کرده ام که در پوشه ای به نام RAWمثلا در اینجا من پوشه ای به نام 

.ساختار درختی دسترسی ما به فایل ها را بسیار آسان کرده است
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ادوبی بریجدر Favoritesپانل علاقه مندی ها 

این پانل به شما امکان دسترسی سریع به پوشه ها و دایرکتوری هایی را که. قرار داردFavoritesدر کنار پانل پوشه ها پانل علاقه مندی ها 

.پانل علاقه مندی ها کاری مشابه بوک مارک ها در مرورگرهای وب را انجام می دهد. بیشتر استفاده کرده اید، می دهد

م پوشه ها و البته ما می توانی. به طور پیش فرض، بریج برخی مکان ها مانند دسکتاپ، پوشه اسناد و پوشه تصاویر را در این پانل قرار می دهد

.مکان های دیگری از کامپیوتر را به این پانل اضافه کنیم
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دربارهراینکهجایبهتامیکنیماضافههامندیعلاقهپانلبهراپوشهاینبنابراینکنیممراجعهRAWپوشهبهبارهااستقرارکهمیخواهیممثلا

.کنیمپیدادسترسیآنبهسرعتبهبپردازم،جستجوبههاپوشهپانل

Addگزینهسپسکردهکلیکراستپوشهنامروییافته،هاپوشهپانلدررانظرموردپوشهاینکاربرای to Favoritesکنیدانتخابرا.

سرعت باحال اگر بر روی پانل علاقه مندی ها کلیک کنید خواهید دید که پوشه مورد نظر شما به این پانل افزوده شده است و از این پس به راحتی و

.می توانید به این پوشه دسترسی پیدا کنید



ادوبی بریجنوار مسیر در

قرارآندرکهموقعیتیمسیرنوارکنیدمیمشاهدهکههمانطور.داردقراربریجاینترفیسبالاییقسمتدرکهاستنواریمسیر،نوار

وبودهEدرایودرخودکهدارمقرارRAWپوشهدرمنچپ،بهراستازبینید،میکههمانطورمثلا.دهدمینشانرادارید

میاستانفعلیتموقعیتمسیردرکههاییموقعیتازهریکرویکلیکباشما.استشدهسیونیزمندسکتاپرویبرهمچنین

.شویدمنتقلموقعیتآنبهتوانید
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ادوبی بریجدر (Content)پانل محتوا

پانلاین.دهدمینشانراشماهایعکس(تصاویرنمایشپیش)بندانگشتیتصاویراینترفیس،مرکزدرContentمحتواپانل

پانلدراکنونهمRAWپوشهمحتوایبینید؛میکههمانطور.استدادهاختصاصخودبهرابریجادوبیاینترفیسازفضابیشترین

.شودمیمشاهدهمحتوا
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با کشیدن . هیدبا لغزاندن اسلایدر موجود در پایین، سمت راست اینترفیس می توانید ابعاد تصاویر بندانگشتی را تغییر د
.اسلایدر به سمت راست، تصاویر بزرگ و با کشیدن به سمت چپ کوچک می شوند



ادوبی بریجدر (Preview Panel)پانل پیش نمایش 

موجود  (Preview Panel)با کلیک کردن روی هر عکس موجود در پانل محتوا، پیش نمایشی از آن را در پانل پیش نمایش 

.در سمت راست، بالا مشاهده می کنید
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س موقعیت زیر با حرکت دادن ذره بین روی عک. اگر بر روی عکس انتخاب شده در پانل پیش نمایش کلیک کنید ابزار ذره بین به کار می افتد
ن ابزار با کلیک بر روی نقطه ای در داخل ذره بین از ای. نمایش داده می شود و شما می توانید وضوح تصویر را بررسی کنید%۱00ذره بین 

.خارج می شوید

پیش نمایش تمام صفحه

گزینهانتخابوviewمنویبهرفتنوتصویریکانتخاببا.عالیستباشدصفحهتماماگرامااستخوبخیلینمایشپیشپانلکهحالیدر

Full Screen Previewدادهمایشنصفحهتمامصورتبهانتخابیتانتصویرکهدیدخواهیدکلید،صفحهرویاسپیسکلیدفشردنیا

.شودمی



ادوبی بریجدر (Review Mode)حالت مرور 

درچه؟نیدکمرورسرعتبهراپوشهیکهایعکسمجموعهبخواهیداگراماعالیستتصویریکدیدنبرایبریجصفحهتمامنمایشپیش

Reviewمرورحالتهنگاماین Modeمنویبهکافیستحالتاینبهرفتنبرای.آیدمیکمکتانبهتصاویرViewگزینهرفته

Review ModeیاوکنیدانتخابراCtrl+Bبفشاریدکیبوردرویرا.
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ش و یا حالت مرور، تصاویر را به شکل یک چرخ افقی نشان می دهد و شما با کلیک روی فلش های چپ و راست موجود در گوشه صفحه نمای

تر همان همچنین با کلیک روی هر عکس عقب. فلش های چپ و راست روی کیبورد می توانید تصاویر را یکی پس از دیگری مشاهده کنید

.عکس نمایش داده می شود
مایش از لیست در صورتی که روی فلش پایین که در کنار فلش چپ و راست است، و یا فلش پایین روی کیبورد کلیک کنید، عکس در حال ن

.انتخاب خارج شده و به تصویر بعد منتقل می شوید
در . روی کیبورد از حالت مرور خارج شده و به پانل محتوا باز می گردید escو یا  xبعد از اینکه تصاویرتان را مرور کردید با فشردن کلید 

.ارج کردیداین حالت تمام تصایر، در حالت انتخاب شده هستند غیر از تصاویری که در حالت مرور آنها را با فشردن فلش پایین از لیست خ



ادوبی بریجرتبه بندی تصاویر در

.بدهیدرتبهستاره،پنجتایکازاستفادهباتصاویرتانبهتوانیدمیبریجادوبیدرشما

ازتصاویر،رویکلیکسپسوctrlکلیدداشتننگهوفشردنبایاوکردندرگوکلیکازاستفادهباراتصویرچندکاراینبرای

.کنیدانتخابمحتواپانل

ارهستپنجآنهابهخواهممیپسهستندمنعلاقهموردهایعکسواقعدرعکسسهاین.کنممیانتخابراعکسسهمنمثلا

.بدهم

Noگزینهاز.کنممیانتخابراستارهپنجرفته،صفحهبالایدرLabelبرچسبمنویبهانتخابازپس Ratingپاکبرای

.کنیداستفادهدارید،نگهخواهیدنمیکههاییعکسرویزدنبرچسببرایRejectگزینهازوقبلیرتبهکردن

https://www.khalayegh.com/computer-skils/photoshop/photoshop-learn-start/what-is-adobe-bridge-3/


.اکنون می بینید که زیر تصاویر شما سه عکس مورد علاقه، پنج ستاره نمایش داده می شود



افیست روی آیکون برای این کار ک. شاید زمانی تصمیم داشته باشید که فقط یک سری تصویر با رتبه مشخص را در پانل محتوا مشاهده کنید

Filter Items by Rating اب کنیدستاره در بالا، سمت راست اینترفیس کلیک کنید و از منوی باز شده چیزی که دوست دارید را انتخ  .

.را انتخاب می کنم Show 5 Starsمثلا من میخواهم فقط تصاویر پنج ستاره ام را ببینم پس گزینه 

نید در صورتی که مجددا بخواهید تمام تصاویر را مشاهده ک
نه کافیست مجددا روی آیکون ستاره کلیک کرده گزی

Clear Filter را انتخاب کنید.



ادوبی بریجدرMetadataپانل متادیتا

پانلوMetadataمتادیتاپانلنمایش،پیشپانلزیر

این.اندگرفتهقرارگروهیکدرKeywordsهاکلیدواژه

.هستندارزشباخیلیمابرایدوهرهاپانل

دانیمبخواهیممیعکسیکبهراجعکههرآنچهمتادیتاپانل

تنظیماتایجاد،تاریخمثلا.دهدمیقرارمااختیاردررا

حالتفایل،نوعوسایزاست،شدهاستفادهآنازکهدوربینی

افزودنبرایتواندمیمتادیتاپانلهمچنین.…ورنگ

.ودشاستفادهماتماسورایتکپیاطلاعاتمثلجزئیاتی

یاومتادیتاپانلراستسمتدرموجوداسکرولنواراز

.کنیداستفادهپانلایندرزدنچرخبرایموساسکرول
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ادوبی بریجدر (Keywords)پانل کلیدواژه ها 

روی.استگرفتهقرارمتادیتاپانلکناردرپانلاین

Keywordsشودبازپانلاینتاکنیدکلیک.

ییهاکلیدواژههایمانعکسبهکهدهدمیاجازهمابهپانلاین

اببیابیم،راعکسآنخواستیمزمانهرتابدهیماختصاص

.کنیمجستجوراآنراحتیبههاکلیدواژهازاستفاده

ابانتخرانظرموردتصویرابتداکلیدواژه،یکافزودنبرای

Newدکمهکرده، Keyword راپانلپاییندرموجود(+)

شدههدادنمایشفیلددررانظرتانموردکلیدواژهکرده،کلیک

.کنیدفعالراآنکنارمربعتیکوکنیدوارد

https://www.khalayegh.com/computer-skils/photoshop/photoshop-learn-start/what-is-adobe-bridge-3/


ادوبی بریجدر (Filter)پانل فیلتر

کهدیدیمقبلا.داردقرارFilterفیلترپانلها،پوشهپانلوهامندیعلاقهپانلزیر

تارهسولیکردتفکیکهمازراآنهاها،عکسکردندارستارهازاستفادهباتوانمی

.نیستمقایسهقابلدهدانجامتواندمیفیلترپانلکهکاریباکردندار

اریختکلیدواژه،چونمواردیحسببرراهاعکستوانیدمیپانلاینازاستفادهبا

ما.دکنیتفکیکهمازدیگرمواردوعکسجهتبودنپرترهیالنداسکیپایجاد،

فکیکتهمازشده،استفادهلنزیاودوربینمدلبرحسبراهاعکسمیتوانیمحتی

.کنیم

تهدسمثلاآن،درموجودهایبندیدستهازیکیابتداپانلاینازاستفادهبرای

راهدستایندرموجودهایتاریخازیکیسپسکرده،انتخابراایجادتاریخبندی

دادهنمایشمحتواپانلدرتاریخآندرشدهایجادهایعکسفقطتاکنیدانتخاب

.شود
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امکان این پانل این. کنار پانل فیلتر قرار گرفته است Collectionsپانل مجموعه ها

کس این ع. را فراهم می کند که بتوانیم عکس های مربوط به هم را گروه بندی کنیم

.ندباشند و حتی در درایوهای مختلف باشها می توانند در کامپیوتر شما پراکنده 

ا هنگامی که عکس ها به یک مجموعه اضافه می شوند، به آسانی می توانید آنها ر

.ببینید درست مثل اینکه همه آنها در یک پوشه قرار دارند



رای آینده زمانی که مجموعه ای از تصاویر دیجیتالی را جمع آوری کرده باشید  یا یک مجموعه ی شخصی که می خواهید تصحیح، بایگانی و ب

.مجموعه ای از ابزارها را برای وارد کردن، ویرایش، و آرشیو کردن عکس در اختیار می گذارد فتوشاپنگهداری کنید،

شروع کار

ای شما می توانید از تکنیک ه. تعدادی تصویر دیجیتال را ویرایش می کنید Adobe Camera Rawشما با استفاده از فتوشاپ و ادوبی کمرا راء 

 Adobe)کار را با دیدن تصاویر قبل و بعد در ادوبی بریج . متفاوت برای اصلاح و بهبود ظاهری عکس های دیجیتالی استفاده خواهید کرد

Bridge شروع کنید.

.ویندوز استفاده کنید Ctrl+Alt+Shiftفتوشاپ را باز کنید، می توانید از کلید میانبر-۱

.کلیک کنید تا فایل تنظیمات ادوبی فتوشاپ حذف شود Yesزمانی که این کار را انجام دادید، بر روی -2

.را انتخاب کنید تا ادوبی بریج باز شود File > Browse In Bridgeمسیر -3

دوبار بر روی پوشه ی مورد نظر خود Contentسپس در پانل محتوا . در بریج، بر روی پوشه ی مورد نظر کلیک کنید Favoritesدر پانل -4

.کلیک کنید تا باز شود

.  ور واضح ببینیدتصویر بند انگشتی را اگر لازم است تنظیم کنید تا بتوانید پیش نمایش های بندانگشتی را به ط( اسلایدر)نوار کشویی -5

https://tutorial24.ir/%D8%A2%D9%85%D9%88%D8%B2%D8%B4-%D9%81%D8%AA%D9%88%D8%B4%D8%A7%D9%BE/


ردن برای تنظیم تراز رنگ سفید، طیف رنگ ها، کنتراست، اشباع رنگ و تیز ک Adobe Camera Rawمی توانید از ادوبی کمرا راء

تید فایل را برای می توانید به عقب بر گردید و هر زمان که دوست داش. به فایل خام به شکل یک نگاتیو عکس نگاه کنید. استفاده کنید

.رسیدن به نتیجه ی دلخواه خود، دوباره پردازش کنید

اطلاعات فایل اصلی را  Bridgeزمانی که در یک تصویر در کمرا راء اصلاحاتی مانند صاف کردن یا برش تصویر را انجام می دهید، فتوشاپ و بریج 

لی را برای با این روش، می توانید هر ویرایشی که می خواهید را در تصویر بدهید، تصویر ویرایش شده را انتقال دهید و تصویر اص. نگه می دارند

.استفاده ی آتی یا اصلاحات دیگر، دست نخورده نگه دارید



ید بعضی از تول. فایل های تصویری بدست آمده خام بوده و نیاز به ویرایش در برنامه نرم افزاری مخصوص خواهد داشت RAWدر عکاسی با فورمت 

شرکت ادوبی .کنندگان دوربین عکاسی و همچنین چندین شرکت تولید کننده نرم افزار، برای ویرایش فایل های خام، نرم افزارهای ویژه ای ارائه داده اند

که اصولا برای ویرایش عکس طراحی و به Adobe Lightroomاز جمله برنامه . چندین برنامه ارائه کرده است RAWنیز برای ویرایش فایل های 

.بازار عرضه شده است

توسط شرکت ادوبی  ACR (Adobe Camera Raw)با توجه به سابقه نرم افزار فوتوشاپ و وسعت کاربران آن، پلاگین ادوبی کمرا راو یا 

(Adobe)  برای ویرایش فایل های خام(RAW)  در محیط فوتوشاپ(Photoshop) این برنامه در نسخه های جدیدتر . طراحی و تولید شد

در حال حاضر یکی از پر مخاطب ترین برنامه های ویرایش عکس های خام  ACRپلاگین . گسترش بیشتری یافت و ابزارهای آن کاربردی تر شدند

.است که عمدتا توسط کاربران فوتوشاپ استفاده می شود



A.  نوار فیلم(Filmstrip)

B. تغییر وضعیت نوار فیلم

C. ابزارنوار

D.  تغییر وضعیت به حالت تمام صفحه(Full-Screen)

E.  مقادیرRGB

F. سربرگ های تنظیم کننده های تصویر

G.  نمودار میله ای(Histogram)

H. منوی تنظیمات کمرا راء

I. میزان های بزرگنمایی

J. کلیک کردن برای نمایش گزینه های روند کار

K. کنترل های هدایت چند تصویر

L.  تنظیمات( اسلایدر)نوارهای کشویی
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ام تصاویر پیش نمایش بزرگی از اولین تصویررا نمایش داده می شود، و یک نوارفیلم پایین سمت چپ، تم،Camera Rawدر کار محاوره ای 

د کار گزینه های رون. نمودار میله ای در بالا گوشه ی سمت راست، طیف های رنگ تصویر انتخاب شده را نشان می دهد. باز را نشان می دهد

تصویر انتخاب شده را نشان می  resolutionکه به پایین پنجره ی پیش نمایش چسبیده است، فضای رنگ، عمق بیت، اندازه، و وضوح تصویر

تنظیمات ابزارهایی که در امتداد بالای کادر محاوره ای قرار دارند به شما اجازه می دهد بزرگنمایی کنید، حرکت کنید، صاف کنید و سایر. دهد

ما می پانل های سربرگی در سمت راست کادر محاورای گزینه های متنوع تری برای اصلاح تصویر در اختیار ش. را روی تصویر اعمال کنید

لاح کنید و تغییرات می توانید تراز رنگ سفید را تصحیح کنید، تن را اصلاح کنید، تصویر را تیز کنید، نویز را بر طرف کنید، رنگ را اص. گذارد

.ذخیره کنید، و سپس از آن ها بعدا استفاده کنید presetهمچنین می توانید تنظیمات را به عنوان . دیگری اعمال نمایید

این دلیل که به. برای کسب بهترین نتیجه در کمرا راء، گردش کار خود را برنامه ریزی کنید تا از چپ به راست و از بالا به پایین حرکت کند

صحیح ا تشما اغلب می خواهید ابتدا از ابزار هایی که در امتداد بالا قرار دارد استفاده کنید و سپس در صورت لزوم به پانل ها بروید و آن ها ر

.شما در ضمن ویرایش اولین فایل تصویری در این کنترل ها سیاحت خواهید کرد. کنید



نه این افزو. به پیکسل ها استفاده می شود تا فتوشاپ بتواند آن ها را درک کند Rawبرای تبدیل تصاویر خام  Adobe Camera Rawاز افزونه 

.عکاسی نمی کنید باز هم می توانید از این افزونه بهره بگیرد Rawحتی اگر در قالب . یک ویرایشگر قدرتمند و در عین حال با استفاده آسان است

تصویر را به  File>Openبا مراجعه به مسیر . به روش غیر مخرب استفاده خواهد شد آماده کنید Camera Rawابتدا تصویری که از سوی فیلتر 

 Smart Filtersمراجعه و به  Filter>Convertانتخاب کنید یا این که تصویر را باز کنید و با ایجاد یک لایه به مسیر  Smart Objectصورت 

کنید تا همه لایه ها انتخاب Shift+Ckickسپس روی لایه انتهایی . برای چندین سند روی لایه فوقانی کلیک کرده و آن را فعال کنید. تبدیل کنید

فتوشاپ آن ها را به صورت خودکار به صورت شیءهای هوشمند . انتخاب کنید Smart Filtersرا برای  Filter>Convertشوند، سپس گزینه 

بروید زمانی که فیلتر را انتخاب  Photoshop CCدر هر نسخه از  Filter>Camera Raw Filterسپس به مسیر . درآورده و محافظت می کند

.کردید می توانید با دو بار کلیک روی نام آن در پنل لایه ها آن را مجدداً باز کنید



یعنی وقتی در محیط فوتوشاپ کار می کنید، تغییرات اعمال شده بر . استPixel-basedاصولا فوتوشاپ یک برنامه ویرایشگر بر پایه پیکسل 

.خوانده می شود زیرا اطلاعات اولیه تصویر را تغییر می دهدDestructiveاین روند اصولا تخریبی . روی پیکسل های تصویر خواهد بود

است و Non-destructiveقرار دارد که یک ویرایش غیرتخریبی Parametricدر نقطه مقابل ویرایش بر پایه پیکسل، ویرایش پارامتریک 

.از این نوع استACRبرنامه کمرا راو 

 Metadataدر واقع اطلاعات تصویر تغییر نمی کند بلکه دستورات و تنظیمات نحوه نمایش آن اطلاعات که به آن فراداده یا متادیتا  ACRدر 

در یک فایل دیگر بطور جداگانه ذخیره می گردد بطوریکه هر زمان لازم باشد  RAWتغییرات اعمال شده بر روی فایل . می گویند تغییر می کند

خام بنابراین با ویرایش متادیتا و ذخیره آن در کنار فایل اصلی فقط نحوه نمایش فایل. را مشاهده کرد RAWمی توان مجددا شکل اولیه فایل 

.تغییر می کند و آنچه ما مشاهده می کنیم در واقع فایل ویرایش شده ای نیست که داده های آن تغییر کرده باشند



ر جداگانه ای هیچ تغییری در تصویر اصلی ایجاد نشده و دستورالعمل و تنظیمات نمایشی و ویرایشی تصویر نیز بطو ACRبنابراین هنگام کار با پلاگین 

لیه تصویر شما می توانید هر چند باری که بخواهید این متادیتا را تغییر دهید و ویرایش کنید بدون اینکه در اطلاعات او. در کنار آن ذخیره شده است

.تغییری ایجاد شود

خروجی بگیرید، در این مرحله است که در واقع دستورالعمل ها و تنظیمات کمرا  JPEGیا  TIFFبا فورمت دیگری مثل  RAWهنگامی که از فایل 

ر که از پس از این مرحله، اگر فورمت جدید تصوی. راو به پیکسل های تصویر اعمال می گردد و تصویر مورد نظر شما با فورمت جدید ذخیره می شود

.حالت خام خارج شده است در برنامه فوتوشاپ تحت ویرایش قرار گیرد، نوع آن یک ویرایش تخریبی خواهد بود

ورت لزوم برای شما باشد، یعنی جایی که پردازش اولیه و توسعه تصویر اتفاق می افتد و در ص( دیجیتالی)باید نقطه شروع در اتاق تاریک  ACRاصولا 

.تکمیل ویرایش ، می توانید آن را به محیط فوتوشاپ انتقال دهید و عملیات تکمیلی را به انجام رسانید



ACRویژگی های پلاگین 

روشنایی ،Contrastکنتراست ،Exposureمتعددی وجود دارد که می توان با آنها مواردی همچون میزان نوردهی  ToolsابزارهایACRدر

Brightness، رنگColor، تراز سفیدیWhite balance، تونالیتهTone، شارپنسSharpness، اصلاح کجراهی رنگیChromatic 

Aberration از خصوصیات خوب ابزارهای . و تنظیماتی از این دست را به خوبی انجام دادACR  می توان به کنترل بالا در عین سادگی استفاده از آنها

.اشاره کرد

ارد، کاربردهای هر ابزار، بهبود زیادی یافته است بطوریکه با مهارت پیدا کردن در استفاده از آنها می توان در بسیاری از مو ACRدر نسخه های جدیدتر 

.بدست آورد که نیازی به ویرایش های بیشتر یا تکمیلی در محیط فوتوشاپ نداشته باشد ACRتصویر نهایی و مطلوبی از خروجی 

پردازنده بسیار خوبی برای تبدیل تصاویر خام و ارتقای آن به عنوان یک توسعه دهنده  ACRبا این وجود خیلی از متخصصین فوتوشاپ عقیده دارند که 

Developer  است و از طرفی فوتوشاپ نیز یک ویرایشگر قوی تصویرPhoto Editor  است و توانایی های ویژه آن، همچنان در پردازش و ویرایش عکس

.مورد استفاده می باشد



ابزارهای مذکور بطور اختصاصی  ACRانجام می شود در محیط فوتوشاپ نیز قابل انجام است، ولی در  ACRبسیاری از تنظیمات کلی که در 

اختصاصا برای ویرایش عکس طراحی شده است  ACRبه عبارتی برنامه . برای فایل های خام و با دسترسی های ساده تری تدارک دیده شده اند

.در حالیکه فوتوشاپ اصولا علاوه بر ویرایش عکس، در طراحی گرافیکی و زمینه های چند رسانه ای نیز بطور اختصاصی بکار می رود

تفاق می در واقع جایی است که پردازش اولیه عکس انجام می شود و تنظیماتی که کل تصویر را تحت تاثیر قرار می دهد در آنجا ا ACRپلاگین 

.اردبرای انجام تنظیمات منطقه ای یا خاص، می توان از محیط فوتوشاپ استفاده کرد که توانایی های فوق العاده ای در این زمینه د. افتد

اتی که در خصوصا اینکه همان عملی. معمولا عکاسان برای ویرایش عکس های خود نیازی به استفاده از کلیه امکانات و ابزارهای فوتوشاپ ندارند

در واقع برای  ACRپلاگین . انجام می گیرد، در مواردی در محیط فوتوشاپ وقت گیرتر و دشوارتر انجام خواهد پذیرفت (ACR)محیط کمرا راو 

.ساده تر کردن فرایند ویرایش تصاویر برای عکاسان طراحی شده است

این است که می توان به راحتی عکس های مشابه را در یک زمان ویرایش نمود، چیزی که معمولا در فوتوشاپ به ACRاز ویژگی های دیگر 

.این خاصیت موجب صرفه جویی در زمان و انرژی عکاس می شود. راحتی امکان پذیر نمی باشد

که هیچ فعالیت می توان به راحتی تنظیمات یک تصویر را که قبلا ذخیره شده است، برای تصویر دیگری بکار گرفت، بدون این ACRهمچنین در 

.اضافه دیگری بر روی آن اعمال نمود



تعبیه شده است که در واقع اکثر  Camera Raw filterفیلتر جدیدی به نام  Photoshopدر نسخه های جدید نرم افزار فوتوشاپ 

نمود و را دارا می باشد و اجازه می دهد بدون تاثیر تخریبی خاصی بتوان تصاویر را در داخل محیط فوتوشاپ ویرایش ACRامکانات پلاگین 

.شد ACRنیازی نیست جداگانه وارد محیط 

را ندارد ولی تعداد زیادی از ابزارهای کاربردی آن اعم از تنظیمات تراز سفیدی،  ACRاگرچه تمامی امکانات  Camera Rawفیلتر 

ایل تصویری برای استفاده از این فیلتر نیازی نیست که حتما ف. شارپنس، کنترل رنگ و خیلی موارد دیگر را در اختیار کاربر قرار می دهد

.پشتیبانی شود و همچنین می توان آن را بر روی هر لایه ای از تصویر که بخواهید استفاده نمایید ACRتوسط 

نیازی نیست که حتما در ابتدای کار که عکس  ACRدر هر مرحله ای از فرایند ویرایش عکس می توان از این فیلتر استفاده کرد و همچون 

.را باز می کنید، آن را بکار ببرید

با باز شدن . را انتخاب کنید Camera Raw filterبرای استفاده از این فیلتر، پس از انتخاب لایه مورد نظر خود، از قسمت فیلتر ها، 

ا پس از انجام ویرایش های مورد نظر خود ب. برای ویرایش لایه مورد نظر از تصویر استفاده کنید (Tools)فیلتر می توانید از ابزار های آن 

.تمام ویرایش هایی که انجام داده اید بر روی آن لایه اعمال خواهد شد، (OK)فشردن کلید تایید 



.نارنجی است/ به بیان ساده نور خوشید سرد و آبی و نور داخلی، گرم و زرد: منابع نوری مختلف، دماهای رنگی متفاوتی نیز دارند

د، به گونه ای طراحی شده است که رنگ های دمایی مختلف را جبران کند، بدین ترتیب رنگ سفی DSLRسیستم  تراز سفیدی دوربین های 

ما اگر تراز سفید دیده می شود و رنگ های دیگر نیز به صورت صحیح نمایش داده می شوند در اغلب موارد این سیستم به خوبی عمل می کند ا

ا دارای ته رنگ سفیدی خودکار در نورپردازی خاصی، به درستی عمل نکند و یا اگر پیش فرض تراز سفیدی نامناسبی را انتخاب کنید، عکس شم

colourهای  cast  یاtint ناخواسته خواهد شد.

زارهای این کار را می توانید با استفاده از اب. عکاسی کنید، تصحیح نرم افزاری تراز سفیدی عکس هایتان ساده خواهد بود Rawاگر با فرمت 

White Balance  درAdobe Camera Raw انجام دهید.

.  به شما این اجازه را می دهد که پس از عکاسی، تراز سفیدی دیگری را برای عکستان انتخاب کنید White Balanceمنوی 

تراز سفیدی 



فید را هنگام یک دوربین دیجیتال تراز رنگ س. تراز رنگ سفید یک تصویر، وضعیت نورپردازی که تحت آن گرفته شده است را منعکس می کند

تراز . ظاهر می شود Camera Rawنوردهی ثبت می کند، و این تراز، مقداری است که در ابتدای کادر محاوره ای پیش نمایش تصویر در کمرا راء 

و ” سردی“است که بر حسب کلوین اندازه گیری می شود و درجه ی  temperatureاولین مولفه دمای رنگ . رنگ سفید شامل دو مولفه است

است که پراکندگی رنگ tintدومین مولفه ته رنگ . قرمز گرم است-سبز سرد یا زرد-تصویر رانشان می دهد که شامل رنگ های آبی” گرمی“

.یا سبز را در تصویر عوض می کند magentaارغوانی 

نده یا نور غیر به عنوان مثال، اگر روشنایی زن)بسته به تنظیماتی که بر روی دوربین خود استفاده می کنید و محیطی که در آن عکس می گیرید 

د، در آغاز کار را اصلاح کنی( سفیدی)اگر می خواهید تراز رنگ سفید. ، ممکن است بخواهید تراز رنگ را برای عکس تنظیم کنید(یکنواخت وجود دارد

.آن را انجام دهید زیرا این کار بر روی تمام تغییرات درون تصویر اثر خواهد گذاشت



 Camera)را از بالای کادر محاوره ای کمرا راء(White Balance tool)تراز رنگ سفیدابزار،  ACRدر محیط 
Raw) انتخاب کنید.

. برای تنظیم دقیق تراز سفیدی، یک چیز که باید سفید یا خاکستری باشد را انتخاب کنید
ه صورت کمرا راء از آن اطلاعات برای تعیین رنگ نوری که منظره در آن عکس برداری شده است استفاده می کند و سپس منظره را ب

خودکار نورپردازی می کند

فید شوند، پس در عکس های پرتره سفیدی چشم سوژه هدف ایده آلی برای ابزار تراز سفیدی است ، بر روی یکی از چشمان سوژه کلیک کنید تا س: نکته 

به رنگ . )به روز شوند و عکس را ببندید Rawکلیک کنید تا تنظیمات فایل  Doneبر روی . از انجام این کار تمامی رنگ های عکس تغییر خواهند کرد

.  پس زمینه و پوست صورت نیز دقت داشته باشید 

https://tutorial24.ir/2014/05/08/%D8%A2%D9%85%D9%88%D8%B2%D8%B4-%D9%81%D8%AA%D9%88%D8%B4%D8%A7%D9%BE-19-%D9%85%D8%B1%D9%88%D8%B1-%DA%A9%D9%84%DB%8C-%D9%BE%D8%A7%D9%86%D9%84-%D8%A7%D8%A8%D8%B2%D8%A7%D8%B1/
https://tutorial24.ir/wp-content/uploads/2014/07/104.jpg
https://tutorial24.ir/wp-content/uploads/2014/07/104.jpg


ن بهترین می توانید از ابزار تراز سفیدی برای پیدا کرد. بر روی هر نقطه ای دیگر از تصویر کلیک کنید، نورپردازی عوض می شود
.  نورپردازی برای منظره به سرعت و به راحتی استفاده کنید

ین می توانید کلیک کردن بر روی نواحی مختلف، نورپردازی را بدون ایجاد تغییرات پایدار و دائمی بر روی فایل، تغییر می دهد، بنابرا
.آزادنه آزمایش کنید



تمرین

تراز سفیدی را کنترل ( عکس ها هم پرتره و هم طبیعت )Rawعکس مختلف با فرمت 10در 
.عکس اولیه و نهایی را ذخیره نگهدارید . کنید 


